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Document Conventions  

Text Formatting Standards 
Table 1: Text Formatting Standards 

Text Type Appearance 

Chapter Heading Font: Calibri, 20 points, Bold, Color: Blue-Grey Hex #425A69, 
RGB: 66,90,105, Left; Line spacing: 21-point, Space Before: 3 
points. 

   Example: Chapter Heading 

Chapter Sub-Heading Font: Calibri, 18-point, Font Color: Blue-Grey Hex #425A69, RGB: 
66,90,105, Line spacing:  Multiple 1.08 
Example: 

  Chapter Sub-Heading 
Section Heading Section Headings are used to label a series of terms or sub-

sections within a Chapter or Chapter Sub-Heading. 
Example:  

Section Heading 
This section describes the process of….  

 

 

 
 

Body Text Font: Callibri, Regular, 10.5 point.  
 
Example: This is body text. 

Titles and Names: Screen Titles, 
Field Names, Product Names, 
Table Column Titles, Command 
Names, Menu Titles 
 
 

Titles are capitalized and in bold.  
Example:  
 

Figure 1: Main System Tree screen of the System Administration 
Client 

 
  Task or step-by-step 

instructions  
Task instructions are usually numbered and often preceded by 
the statement, “To execute this task, complete the following 
steps:” 
Example: 
To perform this task, complete the following steps: 

1. Step 1 
2. Step 2 

 
Buttons Example: 

Buttons within body text, such as this  button, are 
relatively the size shown, and in line with the text baseline, as 
this Share   button is also displayed. 
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Activu product names are 
capitalized, appear in bold, 
followed by the Trademark 
symbol:  TM 

Example: 
Activu vis|ability™ 

Hyperlinks 

Text that is underlined in a blue color are links to cross-
referenced topics in another area of the document. If the link is 
active, when the mouse is hovered over it, a tag pops up 
instructing the User to press CTRL+ Click to follow the link, as in 
the example below: 

Example: Error! Reference source not found. or Error! 
Reference source not found. 

  

Warnings, Tips, Cautions, and Important Notes   

The following message boxes may appear within the text to call special attention to the information 

being described: 
 

 

    

Warning: improper execution can cause unwanted operational effects.  

  

  

  

Caution:  similar to warning, but results will not be non-operational, or dire, if 
improperly followed.  

  

  

Tip: a note to provide insight about the software and its operation. 
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Important:  part of a process that needs to be completed to ensure changes or 
updates are completed.  
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Scope of This Manual 

This manual provides a description of the architecture and administration of the Activu 
vis|abilityTM system and step-by-step instructions for how to install Activu vis|abilityTM software. 
Refer to the following manuals for additional instructions and information regarding other aspects 
of the Activu vis|abilityTM system: 
 
vis|abilityTM 6.1 Desktop Client User Guide 

vis|abilityTM Scripting Guide 

vis|abilityTM API Guide 

vis|abilityTM Getting Started 

vis|abilityTM Administration Guide 
 

Vis|ability System Components 

The vis|ability system, while like 5.4, is comprised of some different components than previous 
versions of the Activu software. This section will identify and define each component. 

AppServer 
The AppServer is a new software application for rendering spaces for mobile users as well as 
synchronizing application sources across multiple destinations. In simple terms it functions in a similar 
fashion to a decoder server, running applications in preset spaces on a display and being captured for 
distribution across the vis|ability system. 

Base Client 
The Base Client is new in vis|ability and functions as a marker for indicating that the PC on which it is 
installed is part of the vis|ability system. It also communicates to the Nexus which vis|ability software 
components are present on the PC, and can modify, remove, and install additional components. 

Capture Client 
Capture Client, previously known as the Activu Advanced Agent, is responsible for sharing both entire 
screens and applications over the network to other components of the vis|ability system. This 
component is essential for full functionality of a desktop client as well as a display server, and for 
using collaboration features. 

The Nexus  
This new component is the hub of the vis|ability system. It communicates with all pieces of the system 
through the Base Client to know when components are online and the details of their installations. 
The Nexus usually resides on the PC containing the System Manager. This is the first piece of software 
that should be installed in a new vis|ability system. 
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Decoder Server 
The Decoder Server is a software component that is designed to offload the decoding of IP streaming 
sources onto dedicated hardware. This component is mostly used for systems that include many IP 
streams that are needed to show concurrently on a single display wall. 

Desktop Client 
The Desktop Client is the main software component for end users. This software allows for 
collaboration between users, as well as control of display walls and custom button panels. 

Device Manager 
The Device Manager is typically installed on a PC in the vis|ability system that will be connecting to 
various hardware devices within the vis|ability ecosystem through IP or serial. These include displays, 
servers, TV tuners, etc. 

Display Node 
The Display Node is the software that powers displays that present visual information from the 
vis|ability system. This software, along with Capture Client, form the backbone of a Display Node, 
which is the PC that runs the software controlling the display wall. 

Installation Manager 
Installation Manager allows a user to install, update, and remove software components from the 
vis|ability system. This software can be installed on any PC in the vis|ability system but must have 
network access to the Nexus. It shows all PCs that have the Base Client installed and allows for control 
of vis|ability software on that PC. Only one instance of the Installation Manager can be connected to 
the Nexus at one time. 

Interface Server  
This software is designed to be the software that translates information from the Mobility Access 
Server for use by the rest of the vis|ability system. 

Link Configurator 
The Link Configurator, usually installed on an end user PC, is designed to allow end users to configure 
the behavior of Link integrations.  

Link Integrator 
The Link Integrator, along with its plugins, allows the vis|ability system to receive information, 
including alerts and alarms, from various third-party systems and send that information to both 
display walls and end users. 
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Mobility Access Server 
The Mobility Access Server software allows mobile devices to connect to the vis|ability system. This 
software is usually installed on a dedicated machine along with the Integration Server. 

Mux Router 
The Mux Router, previously known as the multiplexer, is designed to receive data from Capture 
Clients, including screen shares, and send that information to other endpoints, whether they be 
display walls or other end users. 

System Administration Client 
The System Administration Client, previously known as ASM Admin, software allows for the 
administration of the vis|ability system. This software typically resides on the System Manager as well 
as end user PCs where the end users will be performing administration tasks. 

System Manager 
The System Manager is the main server component of the vis|ability system. This software contains all 
information about the vis|ability system, including users and permissions, sources, and display wall 
information. This component is typically installed on a dedicated PC, virtual, or physical, with the 
Nexus. 

System Manager Prerequisites 

Before the System Manager can be installed on the System Manager server, a few items need to be 
installed first. The first step in installing a vis|ability system is installing the Nexus, usually on the 
System Manager server. The Nexus is the hub of the vis|ability Activu system that monitors the status 
and programs installed on each machine in the vis|ability system that have the Base Client installed. 
The installation files will also need to be copied into the directory designated as the Installation 
Repository. Additionally, the Installation Manager should also be installed to facilitate the pushing out 
of additional software to other machines in the vis|ability system.  Finally, the Base Client will need to 
be installed on every machine in the vis|ability system so that it can communicate with the Nexus. 

Nexus Installation 
The following procedure demonstrates how to install the Nexus: 

Installing vis|ability Nexus 

1. Execute visibilityNexusSetup.msi. 

2. Accept the License Agreement and click Next. 
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Figure 1: Nexus License Agreement 

3. Change the Centralized Update Repository if necessary. 

4. Add an Admin Passphrase and click Next.  

 
Figure 2: Nexus Setup Credentials 
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5. Change the installation directory, if necessary, and then click Next. 

 

Figure 3: Nexus Installation Directory 

6. Click Install. 

 

Figure 4: Nexus Install Button 
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7. Once the installation has completed, click Finish. 

 
Figure 5: Nexus Installation Completion  

10. Once the entire installation has completed, click Close. 

Copying Installation Files 
For the Installation Manager to be able to remotely configure software in the vis|ability system, it will 
need all the installation files for vis|ability to be available in the directory designated in the previous 
section. The following steps show how to format and copy the installation files: 
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Copying Installation Files for Installation Manager 

1. If it doesn’t exist, create a folder on the Nexus PC disk using the name specified in the 
previous section. For example, this is using the default Activu Install Files on the C: drive. 

2. Ensure that installation files that are being copied are placed in a version folder. 

Figure 6: Activu Install Files Folder 

Figure 7: Installation Files 



18 

 

 

www.activu.com  

Ensure all the installation files are contained within their respective installation folders. 

Installing the Installation Manager  
The Installation Manager allows software to be pushed out to other machines in the vis|ability 
system. It can be installed and used on any machine with access to the Nexus, but initial install to the 
Nexus PC is recommended for ease of installation. The following steps show how to install the 
Installation Manager. 

Installing Installation Manager 

1. Execute VisabilityInstallationManagerInstallerSetup.msi and click Next.  

 

Figure 8: Installation Folder Listing 
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Figure 9: Installation Manager Setup Wizard 

2. Accept the License Agreement and click Next.  

 

 

Figure 10: Installation Manager End-User License Agreement 

3. Change the Installation directory, if necessary, and click Next. 
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Figure 11: Installation Manager Setup – Destination Folder 

4. Click Install.  

 

Figure 12: Installation Manager Setup – Install Button 

5. Once the installation complete, select the Launch Visibility Installation Manager checkbox if 
needed, and click Finish.  
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Figure 13: Installation Manager Setup - Completion 
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Installing Base Client  
The Base Client allows the Nexus to see if the machine is running, and which vis|ability software 
packages are currently installed. It also facilitates the installation, update, and removal of vis|ability 
software packages. The following steps outline the installation process of the Base Client. This 
software should be installed on EVERY PC in the vis|ability system. This software will also create a file 
called CommandRouter.conf in the C:\ProgramData\Activu Corporation folder. This file is used to 
point the Base Client to the Nexus and MUST be defined with the IP or machine name of the Nexus 
PC. 

NOTE 

The Base Client can also be pushed out through Active Directory or another service that can remotely 
push MSI files. The following installation flag can be used for specifying the IP or machine name for 
the Nexus PC: 
 
CONFIG_CR_ADDRESS=XYZ where XYZ is the IP address or machine name of the Nexus PC 
 
FORCE_ADDRESS=IP or hostname of Nexus/System Manage r** reference the End User Software 
Packaging and Installation guide for more information. 

Base Client Installation (Needs new screenshots) 

1. Execute VisabilityBaseClientSetup.msi. 

2. Click Next.  

 
Figure 14: Base Client Setup Wizard 

3. Accept the License Agreement and click Next.  
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Figure 15: Base Client License Agreement 

4. Change the Installation Directory, if necessary, and click Next.  

 

 

Figure 16: Base Client Setup Destination Folder 

5. Specify the IP address or machine name of the System Manager, as well as the port of the 
Command Router (if different than the default). It is advisable to click Test Connection to ensure 
that the Base Client will be able to communicate with the Command Router properly. If the test 
is successful, click Next. 
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Figure 17: Base Client Nexus Setup 

6. Click Install. 
 

 
Figure 18: Base Client Install 

  
 

7. Once the installation is complete, click Finish.  
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Figure 19: Base Client Setup Completion 

Using Installation Manager 

The Installation Manager will allow additional software to be pushed to endpoints within the 
vis|ability system, including software updates.  

Launching Installation Manager 
To open the Installation Manager, use the following steps: 
 

Launching Installation Manager 

1. 1. Open the Start Menu, and either click Visability Installation Manager under the Activu folder, 

or type part of the program name and click Visability Installation Manager from the search 

results. 

2. Enter the following information: 

• The IP address of the Nexus and the port if it’s not using the default.  

• Username 

• Password 

3. Click Connect.  
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Figure 20: Installation Manager Log in  

The Installation Manager opens. 

 

Figure 21: Installation Manager Main Window 

Installation Manager Overview 
Overview of Installation Manager Menu 

The following table will list each menu item in the Installation Manager and provide a brief overview 
of its functionality: 
 



27 

 

 

www.activu.com  

Installation Manager Menu 
Table 2: Installation Manager Properties 

Item Description 

File → About Opens a window providing Installation Manager details, including 
version number, license information, and assemblies used 

File → Exit Closes the Installation Manager 

View → Computer View The default view of Installation Manager. This shows all PCs 
connected to the Nexus through Base Client in the left panel with 
each component installed on that system shown on the right 

View → Component View Shows all vis|ability system components in the left panel and 
which connected PCs have the software component installed on 
the right 

View → Refresh View Refreshes the list of available software components, connected 
PCs, and the installation status and versions of installed 
components on PCs 

Repository → Select Target 
Version 

Allows for the change of the software version scanned and shown 
in the Installation Manager. This list is defined by the folders 
contained in the top level of the installation files folder (see 
Copying Installation Files) 

Repository → Upload Patch Allows an updated installation file to be uploaded into the 
repository 

Repository → Rescan 
Repository 

Refreshes the list of available software versions from the 
installation folder 

 

Installation Manager Interface 

The installation Manager interface is mainly comprised of the menu, navigation pane, and details 

pane. The following will describe each interface: 

Navigation Pane 

The navigation pane shows either the list of PCs or list of software components in the vis|ability 

system. Clicking on each item will show the details of that item in the details pane. The highlighted 

item is the one currently selected. 
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Component View 

 
Figure 22: Installation Manager – Component View 

Computer View 

 
Figure 23: Installation Manager – Computer View 
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Details Pane 

The details pane shows the details of the computer or component currently selected. The following 
information is available: 
 

Details Pane (Computer View): 

Item Description 

Select a Package Allows the user to select a predefined package of components 
to add to a system at once, such as everything needed for a 
system manager PC or display node PC 

Add Lets the user select a software component to add to a PC 

Select Updates This will select all checkboxes in the list that have software 
versions to be upgraded from previous versions 

Deselect All This will un-check all update checkboxes 

Component Specifies which components are installed on the currently 
selected system 

Installed Gives the currently installed version of each component 

Available Version Gives a dropdown menu of available versions of each 
component to install within the currently selected build 

Update Lists available updates 

Progress Provides a color-coded progress bar when components are 
being changed 

 

Details Pane (Component View): 

Item Description 

Add Lets the user select a software component to add to a PC 

Select Updates Selects all checkboxes in the list that have software versions to 
be upgraded from previous versions 

Deselect All Un-checks all update checkboxes 

Machine Lists all machines currently available in the vis|ability system 

Status Shows whether machines are online or offline 

Installed Gives the currently installed version of each component. If it is 
not installed, this will be blank 

Available Version Displays a dropdown menu of available versions of each 
component to install within the currently selected build 

Update Lists available updates 

Progress Provides a color-coded progress bar when components are 
being changed 
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Installing System Manager Components using Installation 

Manager 
The System Manager can be installed using the Installation Manager using the System Manager 
Package. This package contains System Manager, System Administration Client, Mux Router, and 
Capture Client. The following steps show how to install this package on the System Manager: 
 

Installing System Manager Components 

1. Open the Installation Manager.  

2. Select the System Manager PC from the list of machines. 

 
Figure 24: Installation Manager – Machine Selection 

3. Select Typical System Manager from the Select a Package drop down menu.  
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Figure 25: Package Selection 

4. Click Install to begin the installation process. 

 
Figure 26: Package Installation Process 

5. Once the installation completes, it’s recommended to restart the System Manager if it didn’t 
occur automatically. 
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Installing Display Server Components using Installation 

Manager  
The Display Server can be installed using the Installation Manager using the Display Server Package. 
This package contains Capture Client and the vis|ability Display Service. The following steps show how 
to install this package on the Display Server: 
 

Installing Display Server Components 

1. Open the Installation Manager.  

2. Select the Display Server PC from the list of machines. 

 
Figure 27: Installation Manager – Server Component Selection 
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3. Select Typical System Manager from the Select a Package drop down menu.  

 
Figure 28: Component Package Selection 

4. Click Install to begin the installation process. 

 

Figure 29: Component Package Installation 

5. Once the installation completes, it’s recommended to restart the Display Server if it didn’t 

occur automatically. 
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Installing Mobility Components using Installation Manager 
The Mobility Server can be installed using the Installation Manager using the Mobility Server Package. 
This package contains Capture Client, Integration Server, Mobility Access Server, and the Mobility 
Website. The following steps show how to install this package on the Mobility Server: 
 

Installing Mobility Server Components 

1. Open the Installation Manager.  

2. Select the Mobility Server PC from the list of machines. 

 
Figure 30: Mobility Server Installation Process 

3. Select Typical System Manager from the Select a Package drop down menu.  

4. Click Install to begin the installation process. 

5. Once the installation completes, it’s recommended to restart the Mobility Server if it didn’t 
occur automatically. 

Installing End User Components using Installation Manager 
End user components can be installed using the Installation Manager using the End User Package. This 
package contains Capture Client and Desktop Client. The following steps show how to install this 
package on an end user PC: 
 

Installing Mobility Server Components 

1. Open the Installation Manager. 

2. Select an End User PC from the list of machines.  



35 

 

 

www.activu.com  

 
Figure 31: Mobility Server Machine Selection 

3. Click Add.  

4. Select Capture Client from the drop-down list.  

 

Figure 32: Capture Client Selection 

5. Click Add.  
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6. Repeat steps 3-6 for Desktop Client, Link Configurator (if applicable), and System 

Administration Client (if applicable). 

7. Click Install to begin the installation process. 

8. Once the installation completes, it’s recommended to restart the End User PC if it didn’t occur  

automatically. 

Additional Software Installation Steps 

Additional System Manager Installation Steps 
In addition to installing components using the Installation Manager, some additional steps need to be 
taken to ensure the System Manager will run properly.  

Setting the machine to Auto-Login 

Having a vis|ability server machine is critical in making sure that the end users need to interact with 
the machine as little as possible. Use the following steps to configure the machine to auto-login: 

Configuring Auto-Login 

1. Copy the autologon.exe file from your installation files repository (or download from 
https://learn.microsoft.com/en-us/sysinternals/downloads/autologon)  to an easily 
accessible folder, such as Desktop or Documents. 

2. Click Agree.  

Figure 33: Additional Installation License Agreement 

https://learn.microsoft.com/en-us/sysinternals/downloads/autologon
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3. Enter the appropriate logon credentials into the Username, Domain, and Password fields 
and click Enable.  

Configuring Capture Client (Update all screen captures and the Capture Client icon) 

The Capture Client is set to ask permission for remote viewing and control by default. For servers, it is 
ideal to change these settings. The following steps will show this process: 
 
Configuring Capture Client for Servers 

To configure Capture client settings, complete the steps:  

1. On the machine, right click on the Capture Client icon and click Show Settings. 

 
Figure 35: Capture Client Settings 

  

Figure 34: Login Credentials  
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2. Change the Confirmation Mode dropdown box to Not Required. 

 

 

Figure 36: Capture Client Settings 

3. Click Dismiss.  

Additional Display Node Installation Steps 
In addition to installing components using the Installation Manager, some additional steps need to be 
taken to ensure the Display Node will run properly.  

Setting the machine to Auto-Login 

See Setting the machine to Auto-Login 
 

Installing Browsers 

For best compatibility, it is recommended to install and Chrome on the machine for displaying 
browser sources.  
 
Google Chrome can be downloaded here: https://www.google.com/chrome/ 
 

Installing Viewers 

The Activu Viewer and VLC are key components that need to be installed to ensure that all media and 
streaming sources can play correctly on a Display Node. The viewers will need to be installed using the 
following steps. They can be found in the Viewers folder of the build used to install vis|ability. 

https://www.google.com/chrome/
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Important:  It is critical that the following steps are followed in the correct order to 
ensure proper installation.  
   

Installing Viewers 

1. Install the latest version of VLC Media Player from the VLCViewer folder. An example 
name is vlc-X.X.X-win32.exe where X.X.X is the version number 

2. Install VLC Viewer from the same folder. It is named VLCViewer Setup.exe 

3. Install the Activu Media Player from the ActivuViewer folder. It is named 
ActivuMediaPlayerSetup.exe 

 

Display Node Configuration File (Change Display Server references to Display Node) 

The Display Server configuration file is typically located in the following folder: 
C:\Program Files\Activu\visability DisplayNode  
This file is called VisabilityDisplayNode.exe.config. There are several configuration options available in 
this file, but the most changed are as follows: 
 

Table 3: Display Service Configuration 

Item Description 

LocalRenderingCapacity The number of sources that are being rendered 
locally that can be placed in a wall. 

DecoderCardCapacity The number of sources that can be placed on a wall 
that are being rendered via a decoder card. 

RecoverSourcesOnStart A Boolean field for whether or not a restarted 
display node loads the existing sources when it 
shutdown/restarted. 

 

Configuring Capture Client 

See Configuring Capture Client 

Additional Mobility Server Installation Steps 
In addition to installing components using the Installation Manager, some additional steps need to be 
taken to ensure the Mobility Server will run properly.  
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Setting the machine to Auto-Login 

See Setting the machine to Auto-Login 
 

Configuring Capture Client 

See Configuring Capture Client 

Additional End User Installation Steps 
In addition to installing components using the Installation Manager, some additional steps need to be 
taken to ensure the end user software will run properly.  
 

Installing Browsers 

See Installing Browsers 
 

Installing VLC 

VLC is a critical component of the end user experience that allows users to view media and streaming 
sources. The x64 version of this software must be installed for the end user software to work 
correctly. 
 
VLC can be found here: http://www.videolan.org/vlc/download-windows.html 
 

 

Important:  part of a process that needs to be completed to ensure changes or 
updates are completed.  
  

  

 

  

http://www.videolan.org/vlc/download-windows.html
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Configuring Capture Client (Update screen captures and the icon) 

Capture Client can be customized by end users according to their preferences. These preferences can 
be accessed by right clicking on the Capture Client taskbar icon and clicking Show Settings. The 
following table will show each feature and its functionality: 
 

 
Figure 37: Capture Client Settings (General Tab) 

Table 4: General Tab Properties 

Item Description 

View Only This checkbox determines whether a remote viewer 
has permission take control of the screen being 
viewed 

Access Mode Enabled: Remote Access is allowed 
Disabled: Remote Access is not allowed 

Viewer Badge Enabled: A badge will be displayed on the main 
monitor of the captured display when being viewed 
from another client or display 
Disabled: No badge will be shown 

Confirmation Mode Not Required: Users can view the screen without 
asking permission 
Reject after Timeout: Users can ask permission to 
view the screen, and the request will be rejected if it 
is not approved or rejected within the timeout 
allowance 
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Approve after Timeout: Users can ask permission to 
view the screen, and the request will be approved if 
it is not approved or rejected within the timeout 
allowance 

Timeout The number of seconds the user must approve or 
reject the viewing request 

H.264 Video Quality This dropdown designates whether the capture 
prioritizes quality or speed of transmission 

  

 

Table 5: Capture Client Privacy Region Properties 

Item Description 

Clear Clears any currently defined privacy area 

Select Region Allows a specific rectangular set of pixels to be set as 
the privacy region 

Select Screen Allows a monitor to be selected as the privacy region 
 

 
 

Figure 38: Capture Client (Privacy Region Tab) 
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The Viewers tab of the Capture Client settings shows the sessions currently viewing the screen of the 
machine and allows individual sessions to be disconnected. 
 
 
  

Figure 39: Capture Client (Viewers Tab) 
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